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OverviewOverview

The following tutorial is a brief introduction on how to 
develop and debug programs using the software and 
hardware tools included with the SKP16C62P. 

To get the most out of the Starter Kit, check out the 
references at the end of this tutorial.

Note:
The tutorial assumes the user has followed the ‘Quick Start Guide’ and all the 
software tools and examples have been installed in the default directories.
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The Development ProcessThe Development Process
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SKP16C62P ConnectivitySKP16C62P Connectivity
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SKP16C62P BoardSKP16C62P Board
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SKP16C62P Board FeaturesSKP16C62P Board Features
M16C/62P(M30626FHPGP) MCU

• 24MHz Operating Frequency at 3.0V – 5V
• 384kB Flash ROM, 4kB Virtual EEPROM, and 31kB RAM
• 87 GPIO and 4 Key-on Wakeup Inputs
• 11 Timers plus a Watchdog Timer
• 26-channel 10-bit ADC
• 2-channel 8-bit DAC
• 2 DMAC
• 5 SIO’s (supports I2C and SPI) 
• CRC Circuit

Onboard User Controls
• LED’s  (3 User, 1 Power)
• Removable 2-line x 8-character LCD
• Pushbutton Switches (3 User, 1 Reset)
• Thermistor and potentiometer tied to an A/D input
• I/O available on Expansion Ports
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ICD (RTAICD (RTA--FoUSBFoUSB--MON)MON)
The ICD (In-Circuit Debugger) provides a USB interface to the Host PC and 

communicates commands and data to and from the SKP16C62P board 
via a synchronous serial interface. 

As a debugging tool (during program debug), the ICD + KD30 downloads a 
small kernel (or ROM Monitor) program with the user program to the 
SKP16C62P Board . This kernel provides a communication interface
between the M16C/62P MCU and the ICD + KD30 Debugger application
on MCU status. While the kernel uses some resources of the M16C/62P, 
the operation of the ICD is transparent to the user’s program.

As a programming tool, the ICD + Flash-over-USBTM(FoUSB) Programmer 
can be used to download user programs to the M16C/62P MCU on the
SKP16C62P Board and other Renesas’ M16C Flash MCU’s (the ICD will 
support other M16C MCU’s by downloading a  MCU Monitor Image (MMI) 
file for a particular MCU thru KD30 or FoUSB Programmer).

NOTE: The kernel is only downloaded with the user program when using KD30 
Debugger but NOT the FoUSB  Programmer.
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Development ToolsDevelopment Tools
Tool Manager

An Integrated Development Environment (IDE) that invokes all 
necessary software for building your project

KD30
PC software that communicates with the ROM Monitor Program 

(in flash on the MCU) for program debug
KNC30

C-compiler (limited version of NC30). Conforms to ANSI C 
standards 

AS30
Relocatable Assembler
Supports structured language and wide variety of macro 

instructions
Flash-over-USB Programmer

Flash programmer for Renesas M16C Flash MCU’s.
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Tool Manager OverviewTool Manager Overview

When writing a microcontroller (or any computer) program, the 
program is usually split into multiple files to make it easier to read and 
understand.

While exactly how the files are organized is up to the programmer, 
typically, the code is split up in a logical manner into various files (e.g. 
math functions in one file, serial port drivers in another, etc). 

After all the files in a project are compiled and assembled, a linker 
combines all the files into a single file. These steps can be tedious and 
repetitive. To make the process simple, we use an Integrated
Development Environment (IDE) called “Tool Manager (TM)”.
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Start Tool Manager (TM)Start Tool Manager (TM)

From the Windows Start menu, click on
Programs > Renesas-tools > TM V3.X > TM
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Tool Manager Project BarTool Manager Project Bar
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Tool Manager ExerciseTool Manager Exercise

We will now perform the following steps:
• Open an existing project
• Build (re-build) an existing project
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Open an Existing Project: Step 1Open an Existing Project: Step 1

To open an existing project, click on this icon.
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Open an Existing Project: Step 2Open an Existing Project: Step 2

Locate the C:\MTOOL\SKP16C62P\sample_code directory and 
open the “tutor1” folder.
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Open an Existing Project: Step 3Open an Existing Project: Step 3

Select “tutor1.tmk”
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Open the Project EditorOpen the Project Editor

Click on ‘Project Editor’ icon.
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Project EditorProject Editor

Normally, you will only be concerned with the editor window.
Now click on the ‘+’ by ‘all’, then click on the ‘+’ by ‘tutor1.x30’, 
then the ‘+’ by ‘tutor.r30’.

Command windowEditor window



18

Editor WindowEditor Window

This illustrates that 
the object file 
‘main_tutor1.r30’
depends on these 
source files.

Double-click on ‘main_tutor1.c’ to open it in the default editor, ’Notepad’. 
Tool Manager can also be set up to use your favorite editor. To change the 
default editor, click on the ‘Tool Register’ icon on the ‘Tool Bar’.
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Build(reBuild(re--build) an Existing Projectbuild) an Existing Project

Build the project into an executable module by clicking on the ‘Rebuild’
icon. This will re-compile and link all the source files. 

Clicking the ‘Build’ icon will only compile files that have been modified 
since the last build. 

Always ‘Rebuild’ when any compiler or Tool Manager options have 
changed.

Clicking on any of the build icons opens the ‘Builder’ window...

Re-build Build 
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Builder WindowBuilder Window
The major use of the window is to determine if any errors, or warnings, 
occurred and where. 

The no. of errors and warnings
will show up in this window.  
You can then scroll up to find 
where the error(s) occurred. If 
no errors were found, ‘…
Finish…’ will be displayed.

Now that you have finished compiling/linking the file, the next step is to 
download and run the program on the SKP16C62P Board using the KD30 
Debugger and ICD…

Do not close Tool Manager yet. We will be returning to it later.
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KD30 Debugger OverviewKD30 Debugger Overview
The KD30 Debugger can be used to verify that the program we 
developed works exactly as we intended and when it does not, we 
can use KD30 to find out why.

Breakpoints can be set in KD30 to stop the program at certain 
points (of our program) so we can verify that up to that point, the 
program still works correctly using registers or variables in 
memory.  The number of breakpoints will vary from MCU to MCU. 
For the M16C/62P, the maximum no. of breakpoints for KD30 is 8.

KD30 also allows “step” execution in our program, which means 
program execution on a per line basis (whether in source level or 
machine code level).

Various windows in KD30 allow us to see register values and 
memory locations.
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KD30 Debugger ExerciseKD30 Debugger Exercise

• Download and run a program on the SKP16C62P 
board

• General use of the KD30 Debugger including 
stepping and setting breakpoints

• Return to Tool Manager, modify the program, rebuild, 
and run the updated program on the SKP16C62P 
board
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Connect HardwareConnect Hardware
Before starting KD30, connect the ICD to the SKP16C62P Board as shown. 
Connect the USB cable to the PC. On the ICD, the Power LED is on and the 
Status (Yellow) LED is blinking once a second (this means that the ICD USB 
driver was loaded correctly by WindowsTM).
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Start KD30Start KD30
Launch KD30 from the Windows Start Menu,

or from ‘Tool Manager’.
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KD30 Init WindowKD30 Init Window

Step 2. Select USB

Step 3. Now click the 
‘Run Mode’ tab

Step 1.  Click on ‘Refer..’ and 
select ‘M30626FHP.mcu’.
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KD30 Init WindowKD30 Init Window

For full debugging 
features, be sure 
‘Sampling Mode1’
is selected.

‘Free Run Mode1’ is 
for real time 
execution of your 
program, but 
debugging is limited. 
Do not select for this 
tutorial.

Now click ‘OK’ to open KD30’s Program window (be sure hardware is 
connected). If you get an error, check all connections. See SKP user’s 
manual  on ‘Troubleshooting’ for details.

Note 1. See KD30 Help for the differences between Sampling Mode and Free 
Run Mode. Also, see the ICD User’s Manual for details on how ICD works 
under these two modes. 
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KD30 Program WindowKD30 Program Window

KD30 will disassemble the flash contents or display ‘UND’
if  the flash is blank.
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KD30 ToolbarKD30 Toolbar

Go Button
Executes target 
program

Step Button
One step execution
of target program

Return Button
Runs the program up to
the higher routine

Break Button
Sets a software breakpoint at the current 
cursor position

SW Button
Sets a software breakpoint

Come Button
Executes the target program
from the value in the
program counter to the
position of the cursor in 
the window

Over Button
Step over function/subroutine call

Stop Button
Stops execution of the 
target program

Reset Button
Resets the target program
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Download a Program to the Download a Program to the 
SKP16C62P Board (M16C/62P MCU)SKP16C62P Board (M16C/62P MCU)

Click on ‘File’, then select ‘Download’, ‘Load Module’.
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Download a Program to the Download a Program to the 
SKP16C62P Board (M16C/62P MCU)SKP16C62P Board (M16C/62P MCU)

In the c:\MTOOL\SKP16C62P\sample_code \tutor1 
directory, select ‘tutor1.x30’.
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Download a Program to the Download a Program to the 
SKP16C62P Board (M16C/62P MCU)SKP16C62P Board (M16C/62P MCU)

Current location 
of MCU 
program 
counter is 
highlighted.

Now click on “View” to see the program source code…

After downloading the program, KD30 opens the file where the reset vector 
points to.
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Viewing Source Files in the ProjectViewing Source Files in the Project
1. Click ‘source’

4. Double-click ‘main’
to view it on the 
Program Window3. Click ‘main_tutor1.c’

2. Source window 
is displayed.
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Running Downloaded ProgramRunning Downloaded Program

Click ‘MIX’ to 
view the source 
code and 
assembler code.

Click on the ‘Go’ icon to run the tutor1 program you just downloaded. 
LED’s D1, D2, & D3 will blink sequentially. Turning the Analog Adjust 
potentiometer on clockwise increases the LED blink rate and turning it 
counter-clockwise decreases the LED blink rate.
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Stopping Program ExecutionStopping Program Execution

Click on the ‘Stop’ icon 
to stop the program
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Setting BreakpointsSetting Breakpoints

2. Locate and then set a breakpoint on ‘led_display();’ by 
a double-click on ‘-’ in the ‘BRK’ column that denotes an 
executable line. A ‘B’ will appear in its place after the 
breakpoint is set and the line is highlighted in red.

1. Click on the ‘Source’ to view source code only (not MIX display).

3. Click on ‘Go’ icon to run program…
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Removing BreakpointsRemoving Breakpoints

Program stops
at breakpoint 
(highlighted in 
Yellow).

You can remove the breakpoint by double-clicking on it at 
the ‘BRK’ column.
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Program Program ‘‘SteppingStepping’’

Try ‘stepping’ a few lines of code by clicking on ‘Step’ icon. Click 
on ‘Go’ afterwards to run program again.
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Basic Windows: RegisterBasic Windows: Register
Now open the ‘register’ window

Note: Resize the ‘register’ window as needed.

The Register window displays the values of the CPU registers after 
executing an instruction. 

Values in red 
indicate changes 
since last 
“viewed”. Try 
‘stepping’ and 
note the 
changes.
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Basic Windows: RAM MonitorBasic Windows: RAM Monitor
Double-click an address and enter 400 (hex). KD30 will tell you the page is 
going to change, click ‘OK’ (adjust the window size as needed). The RAM 
Monitor displays the current value of the memory area shown on the 
window. It is updated at a preset value which can be modified by the user. 

Click the ‘GO’ icon. Note you can view the RAM as it is updating. This 
function is not available in “Free Run” mode. Click the ‘STOP’ icon 
before proceeding.
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Basic Windows: Memory & C WatchBasic Windows: Memory & C Watch

The ‘Memory Window’ displays the
location and contents of variables

Double-click on the variable to 
change display format: i.e., change 
‘char’ to ‘hex’ to ‘decimal’, etc.

The ‘C Watch Window’ allows you 
to view globals and locals. An example 
is shown below.
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Modifying the Program: Step 1Modifying the Program: Step 1

In the Project Editor, click on the ‘+’ by .\main_tutor1.r30. 

Double-click on .\main_tutor1.c to edit it.
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Modifying the Program: Step 2Modifying the Program: Step 2

1. Scroll down and find 
the function ‘ta1_irq’
routine.

3. Save the revised file (from the ‘File’ menu)

2. Change this line to
‘ta1 = (0x3FF – ad0);’.

4. Build the project again.
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Load (reLoad (re--load) Modified Programload) Modified Program
In KD30, with the program stopped, reload code by selecting ‘Reload’ from 
the File menu.

Turning Analog Adjust potentiometer on SKP16C62P Board clockwise
decreases the LED blink rate. Turning it counter-clockwise increases the 
blink rate.
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End of TutorialEnd of Tutorial

This is the end of the tutorial. You can try downloading 
other sample programs from the \Sample_Code 
directory.

For a tutorial on creating a new project, check Tutorial 2 
for details.

In addition, check out the references on the next page.

Have Fun!!
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References and Recommended ReadingReferences and Recommended Reading
All documents that came with the SKP can be found using the “Document 
Description” from the Start > Programs > Renesas-Tools > SKP16C62P 
menu.

• SKP16C62P User’s Manual: This is a “must read” document! It details all the 
things you need to know on how to use the Starter Kit.

• Tool Manager V3.X User’s Manual: To fully understand and get the most out 
of “Tool Manager”, this is recommended reading.

• KD30 Version X.XX User’s Manual: The tutorial only covered the basics of 
KD30. Read this manual to find out all of KD30’s features.

• NC30 Version X.XX User’s Manual: Check this manual out for features 
specific to the NC30 compiler. 

• M16C/62P Datasheet and SKP16C62P Board Schematic: These are required 
to write user application programs for the SKP.

• RTA-FoUSB-MON User’s Manual: Read this manual to understand how the 
ICD works.
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References and Recommended ReadingReferences and Recommended Reading
• M16C/10/20/60 Series C Language Programming Manual: This is a great 

document for any level of programmer. The first chapter is an intro to C 
programming. The next chapter explains the memory map of C programs on 
microcontrollers and the role of startup programs. 

• M16C/10/20/60 Series Software Manual: This document describes the 
instruction set and timing information for the M16C/20/60 series CPU cores. 

• AS30 Version X.XX User’s Manual: Read this manual if you plan on writing 
programs in Assembly or when making changes to the startup file.

• Application Notes and Sample Programs: Application notes and other 
sample programs can be accessed from Renesas Technology America’s 
website: http://www.renesas.com.


